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This user guide was last updated by QTV on October 29, 2001. 

How to use this guide 

The WinCuePro News user guide provides detailed information on how to setup, configure and operate 

the software. 

Audience 

This guide is intended for use by Operators whose familiarity with computers and software ranges from 

novice to expert. 

Structure of this guide 

The user guide is modular in design and can be divided into the seven sections. Each section describes a 

different mode of function for WinCuePro News and therefore can be used alone or in conjunction with 

other sections.  

Chapter 1 Installation 

 

Describes the hardware and software 

requirements. How to install the WinCuePro 

News software and peripherals 

Chapter 2 Introducing WinCuePro News Describes the WinCuePro News Screen, 

toolbars, menu commands and keyboard 

shortcuts 

Chapter 3 WinCuePro News AvidNews 

Interface 

Describes how to set up and run the AvidNews 

interface of WinCuePro News. 

Chapter 4 WinCuePro News Basics Describes how to create and prompt scripts in 

four easy steps 

Chapter 5 The Script Editor Describes how to set read rates and customize 

settings for individual presenters 

Chapter 6 Working with Rundowns Describes how to create and prompt using 

rundowns 

Chapter 7  The Prompter Describes the different scroll controls and how 

they are configured 
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Installation of WinCuePro News 
In this chapter you will learn how to install WinCuePro News on your PC. First we will examine 

the hardware and software you need, and then we will cover the hardware and software 

installation process. 

1 Installing WinCuePro News on your PC 

1.1 Minimum Hardware Requirements 
WinCue will run on the Windows 95, 98 or Windows NT 4.0 operating systems. 

However we recommend your prompter is a Windows NT machine. The minimum 

hardware requirements and recommended specification is as follows: 

Windows 95/98 
 166 MHz Pentium processor (233MHz Pentium 2 or better is recommended) 

 32Mb RAM (64Mb RAM is recommended) 

 50Mb free disk space 

 Adaptec SCSI card 2906 for desktop, Adaptec SlimSCSI 1460 PCMCIA for 

laptop 

 VL bus or PCI bus graphics card (PCI preferred) 

 800x600 16 color VGA display (1024x768 is recommended)) 
 

Windows NT 4.0 
 166 MHz Pentium processor (233MHz Pentium 2 or better is recommended) 

 64Mb RAM  

 50Mb free disk space 

 Adaptec SCSI card 2906 for desktop, Adaptec SlimSCSI 1460 PCMCIA for 

Chapter
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laptop 

 VL bus or PCI bus graphics card (PCI preferred) 

 800x600 16 color VGA display (1024x768 is recommended) 

1.2 Before Installing Your Chosen Operating System 

Before you install your chosen operating system you should configure your SCSI 

card in accordance with the documentation supplied with it.  DO NOT at this 

stage install any hardware supplied with WinCuePro News.  

 

1.3 The WinCuePro News Package 

The WinCuePro News package consists of: 

 

 
Laptop users will receive an IMT 
box, not the IMT scroll card 

 Software (1 CD + license) 

 IMT Scroll Card 

 Scroll Controller 

 User-manual 

 

1.4 IMT Scroll Card 

The IMT scroll card allows WinCuePro News to prompt text in any language. 

Data from the scroll card is sent to the prompter screen via the on-board 

composite video channel. The IMT card also features an on-board genlock port. 

In addition, an IMT scroll control can be attached to the IMT card leaving all the 

ports on your PC free for other peripherals. 

 

1.5 Installing the Hardware - Desktop PCs 

Before installing the WinCuePro News software you have to install the IMT scroll 

card. Your PC must be turned off before the IMT scroll card can be installed. 

The IMT card will have been configured prior to shipment for the settings 

required in your country. Therefore changes to jumpers or dipswitch settings 

should not be necessary. 

Refer to Appendix C for wiring diagrams. 

Installing the IMT Card Inside a PC 

1. Remove the cover from the PC’s case 

2. The IMT card is configured it should be connected to the end of the SCSI cable. 
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3. Find a free full length ISA slot inside the PC 

4. Remove the appropriate blanking plate 

5. Carefully insert the IMT card 

6. Connect the SCSI cable to the IMT card 

7. Replace the PC’s cover 

Connecting a Scroll Control 

The standard scroll control used with WinCuePro News is the IMT scroll control. 

The IMT scroll control port is the 9 pin analogue port on the back of the IMT card. 

WinCuePro News expects the scroll control to be connected to this port.  

The IMT scroll control will not work if it is attached to any other port on your PC. 

Refer to chapter 6 to learn more about all the different scroll controls supported 

by WinCue. 

Connecting a Composite Video Feed 

The composite video port is the BNC port furthest the scroll control port on the 

IMT card. This port supplies the composite video feed to the prompter screen(s). 

Connecting a Genlock Feed 

The genlock port is the BNC port nearest from the scroll control port on the IMT 

card. This port accepts a genlock feed. 

 

1.6 Installing the Hardware - Laptops 

The IMT Scroll card must be attached to your Laptop externally, to do this first of 

all make sure your laptop is turned off. 

The IMT scroll card inside the IMT box has been configured prior to shipment for 

the settings required in your country.  Therefore it should not be necessary to 

open the IMT box or change jumpers or dip switch settings. 

 

Connecting the IMT Box to a Laptop 

1.  Insert the PCMCIA SCSI card into your laptop 

2.  Connect one end of the SCSI cable supplied with the SCSI card to the PCMCIA 

card and the other to the SCSI port on the IMT box 

3.  Connect a power cord to the appropriate input of the IMT box (you have a choice 

of IEC mains or 12V DC) 

See the laptop wiring diagram in Appendix C. 
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Connecting a Scroll Control 

Laptops normally use the IMT scroll control. The IMT scroll control port is the 9 

pin analogue port on top of the IMT box. WinCuePro News expects a scroll 

control to be connected to this port.   

The IMT scroll control will not work if it is attached to any other port on your PC. 

Connecting a Composite Video Feed 

The IMT box is made in two versions, one has four BNC composite outputs and 

the other has one. These ports supply the composite video feed to the prompter 

screen(s). You can connect your video cable to the BNC output. 

See C3 and C4 in Appendix C for further details. 

Connecting a Genlock Feed 

The genlock port is the BNC port next to the IMT scroll control port on the IMT 

box. This port accepts a genlock feed. 

Connecting a Power Supply 

The IMT box can be powered from one of three different sources; the mains 

power supply, 12V DC and an optional PAG battery (UK version only). 

A reset button is provided on the IMT box to reset the IMT scroll card. 

 

1.7 Restarting Your PC 

Once all the WinCuePro News hardware has been installed restart your PC. 

 

 

Warning for Laptop Users! 

 Laptop users must switch on the IMT box before switching on the laptop. 
This is to ensure the PCMCIA SCSI card successfully detects the IMT scroll 
card. 

 

1.8 Installing the Software  

It is assumed you have already successfully installed your chosen operating 

system on a PC and this meets the minimum hardware requirements.   
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  Warning! 

 If WinCuePro News is being installed on Windows NT 4.0 you will need to 
be logged in with administrator privileges.  If you do not have these rights 
contact your computer support department. 

 

 

 

 
To begin installing WinCuePro News: 

1. Close all programs running on your computer 

2. Insert the installation CD into your CD drive 

3. Choose Run… from the Start menu 

 
4. The Run dialog box appears. Type d:\setup in the Open: text box then click on 

OK. 

 
5.  The installation program will load. Follow the on screen instructions carefully.   
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6. Once all the software has been copied onto your PC you will need to shut it 

down and switch it off to install the IMT scroll card. 

  

Warning! 

 The license disk included with each copy of WinCuePro News is designed 
to work with the supplied IMT scroll card.  It will not work with any other 
IMT card. 

 

1.9 Starting WinCuePro News for the First Time 

When WinCuePro News starts for the first time the following message appears, 

“Your scroll control configuration is not set. WinCuePro News will now 
allow you to select which scroll control your have installed”. 

Click on OK. The Configure Scroll Controls dialog box appears. 

 

Choose the appropriate scroll control from the Configure Scroll Controls dialog 

box, and then click on OK.  The WinCuePro News installation is now complete 

and you ready to begin working with WinCuePro News. 
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How WinCuePro News Works 
 

This Chapter introduces WinCuePro News and some of its basic features. If you are familiar 

with Windows you can skip ahead to the next chapter that describes how to create a 

document. This chapter is also a valuable reference section as it describes all the keystroke 

shortcuts. 

2 Introducing WinCuePro News 

2.1 What’s on the WinCuePro News Screen? 

When you start WinCuePro News, a new blank document appears on the WinCuePro 

News Screen. The following illustration identifies each part of the WinCuePro News 

screen. 
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Menu Bar

Word count  

Status bar 

Toolbar buttons 

Script 
Duration

Script 
Editor
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Open menus to display WinCue commands: 

 

Click buttons on the toolbars to quickly choose commands. 

The status bar displays information about the active document or highlighted 

command. The window bar displays the current scripts open as tabs. 

One of the main features of the WinCue screen is the Word count boxes and the 

Script duration boxes. 

See Section 5.1.2 and 5.1.3 for more details on the Word Count and Script 
duration boxes 

As you type the script into WinCue, the Word Count box will track the number of 

words in the script. The current word count is constantly updated and displayed. The 

Words to End box will track the number of words remaining in the script, from a 

specific point within the script. 

The screens described in this section refer to WinCue LT in standard format although 

all screens are configurable using the Layout Editor. Contact your vendor for more 

details. 

2.2 Using the Mouse 

Use the mouse to move the pointer around on the screen to quickly choose 

commands, click buttons, and select text and so on. To move the pointer, just move 

the mouse on your desktop. 
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2.3 Choosing Commands 

A command is an instruction that tells WinCue what to do next. To choose 

commands, you can click buttons on the toolbars or use the regular menus. 

Using toolbars for command shortcuts:  If you have a mouse you can click buttons 

on the toolbar to choose the most common WinCue commands. 

Formatting toolbar 

 

Standard toolbar 

 

To display or hide a toolbar, open the Tools menu, select Toolbars and then the 

toolbar you want to display or hide from the sub-menu. Toolbars selected for display 

will have a checkmark ( ) displayed next to them. 

Choosing commands from the menus: You can also choose commands from 

menus that are listed on the menu bar at the top of the WinCue window. Just click the 

command you want. To close a menu without choosing a command, click outside the 

menu or press ESC. 

 

Selecting options in a dialog box:  When you choose a command that’s followed by 

three dots, a dialog box appears so that you can select options. 

Options greyed out are not 
available in the current 
active window. 
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2.4 WinCuePro News toolbars and tools 

Toolbars provide quick access to commonly used commands and tools. When you 

first start WinCuePro News and open a queue, the Standard and Formatting toolbars 

are displayed just below the menu bar. You can choose the toolbars you want to 

display or you can choose to display none at all. 
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Standard Toolbar 

Function Button 

New File button 
 

Open File button 
 

Open Queue button 
 

Quick browser button 
 

Save queue button 
 

Print button 
 

Paste button 
 

Copy button 
 

Cut button 
 

Prompt button 
 

Stop prompting button 
 

Panic button 
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Formatting Toolbar 

Function Button 

Bold button 
 

Underline button 
 

Italic button 
 

Inverse button 
 

Font button 
 

Color button-white, red, green, blue, yellow  

Justify button -right, center, left 
 

 

2.5 WinCuePro News Keyboard Shortcuts 

Text Formatting 

 

To do this Windows Shortcut 

Underline Ctrl + U 

Italic Ctrl + I 

Bold Ctrl + B 

Change font Ctrl + F 

Inverse Text Ctrl + E 

Color change to Default color (black) Ctrl + 0 

Color change to Red Ctrl + 1 

Color change to Green 

Color change to Blue 

Ctrl + 2 

Ctrl + 3 

Color change to Yellow Ctrl + 4 

Justify text right Ctrl + Shift + R 

Justify text left Ctrl + Shift + L 
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Format all Text Ctrl + Shift + A 

Select all Text Ctrl + A 

 
Deleting and Copying 

To do this Windows shortcut 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Search/replace Ctrl + H 

 
Prompting Shortcuts 

To do this Windows shortcut 

Insert marker Ctrl + M 

Previous marker in script Ctrl + 9 

Next marker Ctrl + 0 

Not prompted text Ctrl + P 

 
Menu Commands 

To use this command Windows shortcut 

Save File Ctrl + S 

 
Function Key Commands 

Key To do this 

F1 Help 

F3 Find Next 

F3 + Shift Next 

F6 Open next item 

F6 + Shift Open previous item 

F7 Commit edits 

F9 Prompter Refresh 
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F11 Edit at prompter 

F11 + Shift Prompt to Editor 

F11+ Ctrl Prompt scroll lock 

 
 
2.6 The Principles of Prompting 

This section aims to provide those who are unfamiliar with prompting systems the 

basic terms involved.  

Prompters 

The prompter is normally mounted on the front of the camera and displays the 

scrolling text created by the script editor for the presenter to read. The text from the 

monitor is reflected onto a special sheet of glass. Thus the presenter can see the text, 

but the camera looks straight through it. 

The Script Editor 

The script editor is used to write and modify the story the presenter is going to read. 

Each story is represented as a one-line entry in the rundown. 

Rundowns 

A rundown is a list of titles representing the stories the presenter is going to read. The 

order in which the titles appear dictates the order in which the stories will be displayed 

on the prompter. 

The Scroll Controller 

The scroll controller is used to control the prompted text. The prompter operator 

controls the speed and direction the text scrolls to suit the presenter.  
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WinCuePro AvStar Interface 
 

In this chapter you will learn how to setup the WinCue prompter to operate with the AvStar 

newsroom computer system and also how to configure the AvStar system to work with the 

WinCue interface. 

 

3 AvStar 

3.1 AvStar Server Setup 

After WinCue hardware and software installation, it will be necessary to configure rxnet resources on the 

news servers, create users for prompting on the news system, and also necessary to setup the WinCue 

software for AvStar operation. 

3.1.1 RXNET Configuration 

WinCue Prompters use rxnet resources to access an AvStar System.  In certain circumstances 

they use multiple rxnet resources.  Consequently, it’s wise to configure many of them, more if the 

system is going to have multiple prompters, even more if the system is also going to be receiving 

data from other systems.  Some AvStar installers configure 20 rxnets on any new install or 

upgrade. Figure one rxnet per show plus two extras (plus rxnets for other systems). 

You can use the fgrep command to pull the lines containing rxnet out of the main configuration 

file.  The following example shows a system with 4 general rxnets available for other systems to 

hookup with for story transfer and 6 dedicated rxnets reserved for the WinCue prompter. 

BUBB_A: fgrep rxnet /site/config 
special    101  0              rxnet    -     -    ; rxnet  
special    102  0              rxnet    -     -    ; rxnet  
special    103  0              rxnet    -     -    ; rxnet  

Chapter
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special    104  0              rxnet    -     -    ; rxnet  
special    105  10.1.100.45    rxnet    -     -    ; Wincue 
special    106  10.1.100.45    rxnet    -     -    ; rxnet 
special    107  10.1.100.45    rxnet    -     -    ; rxnet 
special    108  10.1.100.45    rxnet    -     -    ; rxnet 
special    109  10.1.100.45    rxnet    -     -    ; rxnet 
special    110  10.1.100.45    rxnet    -     -    ; rxnet 

 
A general rxnet has a zero in the third column.  Dedicated WinCue rxnets will have the IP address 

of the WinCue prompter entered in the third column.  These dedicated rxnets are reserved and 

can only be used by the WinCue prompter of that address.  WinCue can also use general rxnets 

if none are dedicated. 

Besides the entries in the body of the config file, there will need to be corresponding entries in the 

appropriate host section of the /site/config file (see the AvStar Operations Manual for more details 

on the config file and editing commands): 

reslist          101 102 103 104 105 106 107 108 109  110 

 

3.1.2 Adding Prompting Users 

When WinCue accesses AvStar through an RxNet, it does so using an account and password.  In 

addition, it uses the destination of the account to guide it to the rundown to prompt.  It’s possible 

to set up one account that only accesses SHOW, for example, but it’s more elegant to set up 

multiple prompting accounts, all of which have destinations pointing to different rundowns.  If 

that’s the tact you take, it’s still advisable to have one high-level access account. 

To create multiple prompting accounts, all of which have destinations pointing to different 

rundowns, in AvStar click Tools  Options  Users to bring up the Manage User Accounts 

dialog box: 
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Click on the New User button to add a user.  To keep some sort of uniform standard, name the 

user “winq” (for WinCue) plus the name of the show such as “6p” for the SHOW.6P rundown: 

 

The Destination queue usertrait should be set to the directory name of the show you wish this 

user to prompt.  The Mail queue should be set to the SYSTEM.SHREDDER.  Do not set the Mail 

queue to the DEAD file. 
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No other user features need be checked.  Once the user’s traits are setup, click the Add button to 

add the account. 

After adding the new account, it is necessary to then set a password on it.  Search for that new 

account name by typing the name in the User ID box and clicking Search:  

When the username is found, click the Modify button so you can go in and set the WinCue user’s 

password.  After clicking Modify, uncheck the Force Change box and then click the Password 

button: 

 
You can now designate a password for the show prompting user accounts.  You will need to 

remember this password later when you are setting up the WinCue software. 
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As mentioned, it might be a good idea to also set up a higher-level prompter user whose 

destination is set to the SHOW directory: 

NOTE:  There is currently (1.1.7) a bug in rxnet that prevents WinCue from accessing queues 

with read groups.  Rundown queues that are going to be prompted can’t have a read group.  This 

is expected to go away in 1.2. 

Additionally, in AvStar versions earlier than 1.1.9, it’s important to synchronize the date/time on 

the news servers.  If the time differs more than 5 seconds between the servers, the WinCue may 

not be able to download stories created on the server other than the one the WinCue is logged in 

to.  The resulting error message on WinCue is: 

AvStar Interface:  unable to retrieve story 
 

If you get this message when trying to download certain stories, simply re-sync the time on the 
news servers with the date command, and then modify the affected stories.  This bug is fixed in 
AvStar 1.1.9 and higher. 

3.2 WinCue Prompter Configuration 

HOSTS File Setup 

The WinCue PC needs to be on the network.  It either needs to be able to find the AvStar system 

through a DNS, or it needs a local HOSTS file.  Under NT the HOSTS file lives in 

c:\winnt\system32\drivers\etc\.  It is preferred to edit it from a command prompt, to 

prevent programs like NOTEPAD from sticking a .TXT extension on it. 
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C:\> cd \winnt\system32\drivers\etc 
C:\> edit hosts 

On Windows95 systems, the HOSTS file lives in the Windows directory. : 

An easy way of determining if the WinCue PC is properly setup to find the AvStar servers on the 

network is to run a ping test.  Click Start  Programs  Command Prompt.  This will fire up a 

DOS window.  Simply type “ping <servername>” at the DOS prompt.  If the Windows PC can look 

up the name and it is on the network with the server, you will receive replies as your ping 

bounces off the AvStar server:  

C:\> ping bubb_a 
 
Pinging bubb_a [10.1.0.1] with 32 bytes of data: 
Reply from 10.1.0.1: bytes=32 time<10ms TTL=255 
Reply from 10.1.0.1: bytes=32 time<10ms TTL=255 
Reply from 10.1.0.1: bytes=32 time<10ms TTL=255 
Reply from 10.1.0.1: bytes=32 time<10ms TTL=255 
 
C:\> 

If the hosts table is not properly setup, the Windows PC will be unable to look up an address to 

correlate to the name and an error message will result: 

C:\> ping bubb_a 
Bad IP address bubb_a. 
 
C:\> 

 

WinCue Hardware Configuration 

The SCSI card and IMT card must be correctly installed and the hand controller needs to be 

connected to both the Port on the IMT as well as a COM port (that’s why it has two connectors on 

it).  The video output is connected to the BNC connector farthest away from the hand controller 

port.  The BNC connector in between is a GenLock connector.  The software needs to be installed, 

it can be put it in the Startup Group for all users. 

AvStar News Interface Configuration 

Configuration of the AvStar interface on WinCue is done through the TOOLS:OPTIONS menu.  

When you select that you’re presented with a tabbed control panel from which you can configure 

many aspects of WinCue.  Four important options in that dialog are Access Control, News 

Interfaces, Prompt Engine, and User Preferences. 
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 “Access Control” is effective on NT based WinCue prompters.  It’s related to the NT accounts on 

the prompter computer.  It’s possible to restrict access to TOOLS:OPTIONS, for example, to the 

NT administrator account.  If you login to the PC as a user named prompter, for example, you can 

configure it so that prompter can’t access or change WinCue setup features. 

Click on Tools  Options to bring up the main WinCue configuration screen: 

 

Click the + sign next to News Interfaces to expand the option and then highlight AvStar: 
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In this screen you are able to setup “servers.”  Click the Add button.  The Configure AvStar 

Server dialog box will appear: 



WINCUEPRO FOR AVSTAR USER GUIDE  GETTING STARTED WITH WINCUEPRO NEWS 

VERSION 1.30 30   QTV   2001 

 

Although the dialog box talks about setting up a Server Name, it is easier to think of the dialog 

box as setting up a Show.  For each show that you are setting up, there should be a 

corresponding user on the AvStar system whose default destination points to that show. 
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In the previous example, the destination of the winq11p user is set to SHOW.11PM. 

Be sure that both “Use New FTP Interface” and “Use Fast Mode” are checked in.  You will be 

unable to browse the AvStar directory tree if Use Fast Mode is not checked. 

AutoSelect Dir. - If you know that this server is only ever going to prompt a queue called rundown 

you can set that to .rundown (that’s <dot>rundown).  In theory, that will only allow that 

server/show to see queues that are called rundown. 

Direct to Queue - If this is box is ticked the AutoSelect Dir path will be grayed out and wincue will 

use the path specified when opening this server  

“Background Download” lets the system start prompting before having downloaded the whole 

show. 

NOTE:  Some AvStar customers who’ve experimented with this think that it made the WinCue 

less             stable and they opted to not use this option. 

After setting up the show in this General Settings tab, click the Host Configuration tab to setup the 

connection to the AvStar server.   
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This is where you can show WinCue which server to login to.  You can also set up a secondary 

server WinCue should login to if the first server is down or not responding. 

NOTE:  The names given here must be listed in the local hosts table of the WinCue PC so that 

the names (bubb_a or bubb_b) can be looked up and referenced to an IP address. 

If a primary or secondary server is not entered, the WinCue will not know where to retrieve 

stories.  The following error message will result when you try to open the queue: 

 

Click OK to save this show configuration, then click Add again to add the next show.  
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Continue adding shows until you have a configuration saved for each show. 

As you are setting the primary and secondary machines in the Host Configuration tab, try to 

alternate the shows from one host to the other so that the shows alternate in a ping-pong fashion 

between the servers they download from. 

Time of Show Primary Host Secondary Host 
5:00 pm “A” server (bubb_a) “B” server (bubb_b) 
5:30 pm “B” server (bubb_b) “A” server (bubb_a) 
6:00 pm “A” server (bubb_a) “B” server (bubb_b) 
10:00 pm “B” server (bubb_b) “A” server (bubb_a) 
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Additional News Interface Configuration 

There are several other tabs at the top of the WinCue Configuration window: 

 
 
The “Other Settings” tab has some important settings.   
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First of all, this is where you configure the Font you’re going to prompt with under the “Font” 

button.  
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Ok or Cancel will bring you back to the Configuration Screen  
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“Trashcan Control” – Sets the size of the trash can and weather you want to keep replaced items 

“Text Processing” - tells the WinCue to respect the tab characters inserted into the scripts by    

writers.   If this isn’t selected, WinCue will pack out those tabs.   

“Convert String To Marker” – When WinCue receives the specified string it will insert a marker 

into the script 

“Allow On Air Delete” – Deleted items on Avstar will be deleted from WinCue  

“Allow On Air Updates” – Updated items on Avstar will be updated on WinCue 

“Allow On Air Editing” – WinCue can edit sent items If this is not ticked then sent items can only 

be   edited in panic mode 

“Only Display Rundown Title” – If this is ticked WinCue will display the queue path as the title 

otherwise it will display the Avstar queue path 

“Convert Leading Spaces To Tab” – If ticked any spaces immediately following a hard return will 

be converted to tabs 

“Dial Up Connection” – Changes the update checking time  

“Force Text To Upper Case” – Changes all received text to upper case 

“Float Empty Items” – All empty items (no text) are put on hold 

“Strip Not Prompted Text” – Any text marked as “Not Prompted” in Avstar is received by WinCue 

“Convert Single Spaces To Double” – Single spaces in the script will be converted to double 

spaces  

“Strip Trailing Hard Returns” – This will remove any extra hard returns that are on the end off the 

script 
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The next two tabs  “Presenter Settings” and “Presenters” are interesting but they’d take a while to 

configure.  WinCue should be able to read the contents of the Presenter Field and, if there’s a 

corresponding WinCue presenter set up, prompting that script will call up that presenter’s 

settings.  That could include different fonts, sizes, and colors. 
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The “Banner” tab controls the formatting of the slug lines in the prompter output.  You can choose 

whether to show banners or not (if you choose not to, WinCue will still show blank space where 

the banners were while prompting because WinCue downloads every story it will show every slug 

line for every story, even blank ones, while prompting) choose the Font and Size for the Banners 

and also choose which fields to show. 

NOTE:  Later versions of the WinCue software do not prompt blank stories and do not put up a 

slug line on the prompter for blank stories.  Contact QTV to obtain the latest version of the 

software. 

Additional WinCue Settings & Preferences 

The WinCue Configuration dialog box has several other settings besides the News Interface. 

 

Under” Prompt Engine you’ll find two choices, “Hardware Settings” and “Scroll Controls”.  

“Hardware Settings” gives you some control over basic display settings.  It’s pretty self-

explanatory.   

 “Scroll Controls” lets you pick what controller to use, generally the “Hybrid Serial/IMT Multibutton 

Controller.  There’s a “Setup” button, which lets you, well, setup your desired controller.   

One important option in there, particularly for people used to the old Serial Prompter controller, is 

the “Center Stop Mode” check box.  If that’s not selected, the controller only works in one 

direction at a time.  If it’s selected, the controller stops in the middle, rolls ahead when you roll the 
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pot forward and rolls back if you roll the pot backward.  You can also configure what the buttons 

do as well as other things.  Explore, play, and learn. 

There are some important settings under “User Preferences”: 

 

Under the “User Interface” tab, typical selections may be as follows: 

•   “Open The Queue Browser”, under “Startup options”.  That brings up the browser 

window (where you see the servers you configured) on program startup. 

•  “Automatically open the Queue Browser once the last Queue is closed”, under “Queue 

Options”.  That re-opens the browser when you close a queue you’re prompting. 

•  “Restore Main Window Position” under “Main Window”.  Not sure but it makes me feel 
warm and fuzzy. 

 
Under the “Windows” tab one typically may select the following: 

•   “Maximize View Window”, which I believe forces the Application to open Maximized. 

•  “Splitter View”, which gives a window on the text being prompted on the VGA status 
display. 

The rest were left at defaults.  Under “Prompt Tracking” the following were selected: 
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•   “Auto Follow On Prompt Item” 

•  “Keep On Prompt Item Visible In List”, which forces the VGA status display to scroll down 

with the prompter output. 

•  Don’t select “Auto Jump to Editor on Speed Zero”, which is really only useful if you’re 

prompting in a non-AvidNews environment and I figure could panic a prompter operator. 

And, when all is done, click on the big OK, exit the Application and launch it again.  Many WinCue 

settings require a restart of the Application to take effect. 

 

3.3 Prompting AvStar with WinCue 

Selecting a Show for Prompting 

If the queue selection window is not configured to open automatically as a user preference when 

starting up the WinCue program, click on File  Open Queue.  This will bring up a dialog box 

where you can select which show you want to prompt: 

 
After you select the Show, you will be presented with a list of the queues underneath this show 

directory.  Select the RUNDOWN queue to download the stories in the show to the WinCue 

prompter. 



WINCUEPRO FOR AVSTAR USER GUIDE  GETTING STARTED WITH WINCUEPRO NEWS 

VERSION 1.30 43   QTV   2001 

 
 

If you wish to change to a different show to prompt, you can click the folder icon with the up arrow 

on it  

to move up one level where you will find other shows available for prompting. 

 

NOTE:  You will not be able to move upwards if you have not configured more than one show. 

If the AvStar user account associated with the show has the actual rundown queue set as the 
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user’s destination in AvStar: 

 

Then when the show associated with that user is selected, the following box appears: 

Choose “Open This Queue” to download the stories in that rundown to the WinCue.  

Multiple shows can be selected and downloaded to the WinCue.  Each appears in its own window 

and can be selected using the “Show Taskbar” at the bottom of the WinCue main window. 

Initiating Prompting 

When you are ready to start a show, click Prompt  Begin Prompting to start prompting.  A 

Begin Prompting icon also appears on the toolbar of the WinCue application. 

It is possible to load more than one show at a time and have multiple rundowns in their own 

windows on WinCue, but prompting must be turned off on the first show before prompting the next. 

After loading the show, changes to stories will be automatically detected and downloaded (WinCue 

polls the AvStar server every second to see if any stories have been added or modified). 

If a story is re-ordered in the line-up, it will automatically pop into its new position on the WinCue 

monitor within a second of being dropped into the new position.  Stories should be reordered on the 

AvStar system rather than on the WinCue. 

The current position of the story being prompted is highlighted in yellow on the WinCue monitor. 

If a story is “floated” in AvStar (Story  Float), the line for that story will turn a different color on 

the WinCue (blue) and that story will not be prompted by the WinCue.  It will also not display a 
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slugbar for the floated story.  WinCue will transparently prompt to the next item, skipping over any 

floated stories. 

Information Displayed on the WinCue Monitor 

A yellow bar on the runorder indicates which story you are currently prompting, the 'prompt bar'.  

A black bar on the runorder indicates which story you have 'selected'. This can be done by left 

clicking on with the mouse; this black bar can be ignored.  

A blue bar on the runorder indicates a story, which has been 'floated' and will not be prompted. 

Double left-click on a story to view the text of the story, use the far-right scroll bar to view more of 

the story.  

The runorder word count column displays the number of words in a story. If there are no words in a 

story its word count box will be colored red to indicate that it may be worth querying the booth why 

there is no text in the story.  It is only worthwhile querying a story if you believe that there should be 

some text in the story.  

The runorder status column displays information about the status of a story.  

If a stories status box is colored red it indicates that the status information is relatively important 

and may be worth querying.  

The status messages and their meanings:  

Updated - The story has been updated/re-downloaded since the original AvStar download.  

The following message will appear in a red status box:  

MISSING - The runorder item/slug has been downloaded from AvStar but the corresponding story 

file has not been downloaded from AvStar.  Likely cause: The story has not been downloaded yet, 

or the story may not contain any text on AvStar.  

Using WinCue to Select the Next Story to Prompt 

If it is necessary to jump the prompt to a story that is not the next or previous story in the runorder 

then you can use any of the following three methods.  

1. Hold down the left 'Alt' key and double left-click on the story you want to start prompting.  
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2. Right-click on the story you want to start prompting, then select 'Prompt From Here' from 

the drop-down menu that appears. 

3. Left-click on the story you want to start prompting, this will select the story (shown by the 

black bar), then hold down the left 'Alt' key and press the 'Return' or 'Enter' key.  

After using any one of these methods, the prompt and the WinCue prompt (yellow) bar will 

move/jump to the chosen story.  

3.4 Using the Scroll Controllers 

Note: IF YOU HAVE A MULTIBUTTON CONTROL WITH OR WITHOUT A FOOT CONTROL:  

The button on the back of the Multibutton Hand Control switches between whether the Multibuttons 

scroll knob or the attached Foot Controls (NB. A Foot Controller may not be attached) pedal is to 

control the scrolling.  

If the button is OUT then the scrolling is controlled by the Multibuttons scroll knob.  

If the button is IN then the scrolling is controlled by the Foot Controls pedal.  

Using the Multi-Button Hand Controller 

The Multibutton Hand Control has twelve buttons and a scroll knob on its right hand side. The scroll 

speed is controlled by turning the knob. The functions of all the buttons on the Multibutton are listed 

below:  

Top row of buttons (left to right): 
 
FWD  Change the scroll direction. The scroll direction is indicated by the cue marker on 
REV  the prompt output. If the cue marker points in towards the story, you are scrolling  

forwards. 
 
NEXT  Jump the prompt forward to the next story. (An ITEM is a STORY) 
ITEM 
 
 
PREV  Jump the prompt back to the previous story. 
ITEM 
 
RESET  Reset the prompt back to the start of the current story. 
ITEM 
 
Middle row of buttons (left to right): 
 
NEXT  jumps to the next marker in the item that is being prompted  
MARKER 
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PREV  jumps to the previous marker in the item that is being prompted 
MARKER 
 
RESET  Reset the prompt back to the start of the current runorder. 
R.O.  Must be pressed after receiving the initial AvStar download. 
 
BLANK    Blanks/Un-blanks the prompt output. (Useful if you feel an interviewer may be put 
SCREEN  off by prompt on the camera) 
 
Bottom row of buttons (left to right): 
 
CAPTION  No assigned function for the AvStar Interface. 
ON/OFF 
 
2nd from left, Known as the  'CUE STORY' button, it will move the prompt back to the very end 
of 
bottom row. the previous story. This is useful to ensure that you are not pre-empting the 
gallery 

as to which is the next story to prompt. Yet you are still able to display enough of 
the 

next story for the presenter to start reading it. It is only worth using this button if  
AvStar controls the runorder. 

 
CLEAR  No assigned function for the AvStar Interface. 
DECODER 
 
STOP  Stop/Re-start the prompt scrolling. 

.  

Using the Foot Control to Prompt 

The scroll speed is controlled by increasing and decreasing the pressure applied to the foot pedal 

(much like a car accelerator pedal). The red button on the foot control changes the scroll direction 

in the same way as the Multibutton controllers FWD REV button.  

If the Foot Control is attached to the back of a Multibutton Hand Control then the Foot Control can 
be used in combination with the Multibutton Controls buttons.  
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Getting Started with WinCuePro News 
 

In this chapter we explore the basic commands and functions you will need to know to begin 

working with WinCuePro News. We will describe how to use WinCuePro News in four simple 

steps and start prompting. By the end of this Chapter you will be able to create scripts and 

prompt them using WinCuePro News. 

4 WinCuePro News Basics 

4.1 Starting WinCuePro News 

The first step is starting WinCue. Normally, you start WinCue from within Windows by 

double clicking on the WinCue icon. When WinCue has loaded the WinCue Client 

window appears. All script editing work is carried out here. 

WinCue can also be found in the Programs-WinCue Applications folder:  

 

Chapter

4



WINCUEPRO FOR AVSTAR USER GUIDE  GETTING STARTED WITH WINCUEPRO NEWS 

VERSION 1.30 49   QTV   2001 

4.2 Creating a New Script 

The WinCuePro News Client window is displayed when WinCuePro News is loaded. 

All script editing work is carried out here: 

 

To create a new script, choose File then New…from the menu.  

OR click the New File button on the Toolbar: 
 

 

A Select New File Type dialog box will appear. Select Simple Script File from the list 

and click OK.  An Untitled Simple Script File will appear inside the WinCue Client 

window: 
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To create your script just start typing. 

The cursor is automatically placed on right hand side of the Script Editor window. The 

text, which is written, in the window, will appear on the prompter’s output. To add text 

to this window, just start typing. When the text reaches the right hand margin, 

WinCuePro News automatically “wraps” the following text to the next line. 

The blinking insertion point indicates where the text you type will appear. If you want 

to work in a different location in a document, you need to move the insertion point. To 

do this, use the mouse to move the I-beam to the new location, and then click.  

Adding Markers to a Script 

When prompting, it is sometimes useful to be able to jump to specific parts of a script 

without having to scroll to that point. Markers are placed at points where the operator 

may need to jump too. 

To insert a marker, place the cursor in the position in the text where the marker is 

required. Choose Insert then Marker from the menu. A flag marker is inserted in text. 
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You can jump between markers in the text using the scroll controller - see 
Section 7.4. 

Adding Presenter Name to a Script 

To add the name of the presenter to your script open the Insert menu and select 

Presenter. The select Presenter dialog box will appear. Click on the presenter name 

you wish to insert and click OK. 

Note:  To add a new presenter to the list of presenters see Section 5.4.1. 

Printing a Script 

To print your scripts choose File then Print… from the menu.  

OR click the Printer button on the toolbar: 

 

The Print dialog box appears: 



WINCUEPRO FOR AVSTAR USER GUIDE  GETTING STARTED WITH WINCUEPRO NEWS 

VERSION 1.30 52   QTV   2001 

 

Choose the number of copies and ensure there is Print Layout Name selected. Click 

OK to print. 

 

4.3 Saving Your Work 

It is good practice to save your work regularly while writing your script just in case 

there is a problem with the PC saving a Script for the First Time 

To save a script for the first time, choose File then Save from the menu. The Save As 

dialogue box appears. Type in a name, which briefly describes your script in the File 

name text box and click on the Save button. 

4.3.1 Saving Changes 

To save changes made to a script, choose File then Save from the menu. The script 

changes will be added to the existing saved File. 
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Use the Save button on the Toolbar to save your work: 

 
 

4.4 Prompting a Script 

Once you have finished typing your script, now its time to prompt it. 

Beginning a Prompting Session 

When you are ready to prompt your script choose Prompt then Begin Prompting 

from the menu. The first few lines of your script will appear on the prompter’s screen. 

Use the Scroll control attached to your computer to prompt the text. 

 

 

When prompting the Word Count box and Time box will turn yellow. 

 
Use the Begin Prompting button on the Toolbar to prompt your script: 
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IMT Scroll Control 

The two button serial control allows you to scroll the text up and down the screen and 

jump between markers. 

To scroll the text, turn the knob at the end clockwise to speed up and anticlockwise to 

slow down. 

To change the direction of the prompted text, press the black button. 

To jump to the next marker press the red button. 

Ending a Prompting Session 

When you have finished prompting your script, choose Prompt then Stop Prompting 

from the menu. This will clear the prompter’s screen. 

 

 

Controlling Prompt and Edit Positions 

An important feature of WinCuePro News is the ability to control the relationship 

between the prompt output and the edit screen. The different options and functions 

are described below. 

In Script Lock Mode, the prompt output is prevented from scrolling and is tied to the 

edit screen. Any changes made on the edit screen are immediately reflected on the 

prompter, and if you move around in the editor, the prompt output will follow. Use 

Prompt, then Script Lock Mode (or Ctrl F11) to enable this way of working. A tick ( ) 

will appear next to the menu option to show that the mode is active. Use the same 

command to return to normal operation. 

If Script Lock Mode is not in use, you can force the prompter to jump to the current 

edit position by using Prompt, and then Jump prompt to editor (or Shift F11). 

Alternatively, you can make the editor jump to the same position as the prompter by 

using Prompt, then Edit at Prompt Position (or F11). 

 
Use the Stop Prompting button on the Toolbar to stop prompting a script: 
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It is also possible to make the editor catch up with the current prompt position every 

time scrolling is stopped. Choose Tools, Options to get to WinCuePro News 

Configuration. Click on User Preferences from the list of options, and then click the 

Prompt Tracking tab. If the Auto Jump to Editor on speed zero option is ticked, the 

editor will keep catching up with the prompt output. There are two other options on this 

preference page, both related to behavior while prompting with a WinCuePro News 

running order. The Auto Follow On Prompt Item option will force the edit script to 

change each time the prompter moves to a new item. Keep On Prompt Item Visible In 

List will automatically move the running order so that the item currently being 

prompted is always visible on the screen.  

Used together, these functions and configuration options can allow the operator to 

work in very different ways. At one extreme, you could be editing part of a script that is 

at the other end of the show from what is currently being prompted, with no 

interference between the two. Alternatively, by locking the prompter to the editor, the 

presenter can see every change that you make.  
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4.5  Getting Started in WinCuePro News Summary 

To Do this Button 
Start WinCue Double-click the WinCue icon 

 

Create a new script On the File menu, select New 
 

Add markers to a script On the Insert menu, select Marker  

Add presenter to script Select Presenter from the Insert 

menu. Select required presenter 

and click OK 

 

Print a script On the File menu, select Print 
 

Save a script On the File menu, select Save 
 

Prompt a script On the Prompt menu, select Begin 

Prompting 
 

 On the Prompt menu, select Stop 

Prompting  
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WinCuePro News Script Editor 
 

In this Chapter you will learn how the script editor works. The Script Editor is used to create the 

prompting text and is similar to many Windows based editors. Therefore, if you have used 

Windows based word processors commands will be familiar. At the end of this chapter you will 

be able to set read rates, fonts, colors and styles to suit individual presenters, and also change 

the editor's layout to suit the way you work. This chapter applies to all versions of WinCuePro 

News. 

5 The Script Editor 

5.1 The Script Editor Window 

The Script editor is used to create the scripts. The Script Editor window has three 

main features. 

The Script Window 

The script is created in this window and this represents what will be seen when 

WinCuePro News is in the prompt mode. The text is written white on a black 

background. 

WinCuePro News supports both mouse and keyboard controls. A summary of the 

shortcut keyboard controls is shown below. These keystrokes will help you to move 

around the editor quickly. The cursor can be moved anywhere in the script using the 

cursor keys or the mouse. 

Text can be deleted using the Backspace and delete keys or by highlighting the 

desired text and pressing the delete key. 

Chapter
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Key To move 

HOME To the beginning of a line 

END To the end of a line 

Page Up Up one screen 

Page down Down one screen 

Ctrl + HOME To the beginning of the script 

Ctrl + END To the end of the script 

 

The Word Count Boxes 

As you type a script WinCuePro News will keep track of the number of words in the 

script. The current word count appears in the Total Words box and is constantly 

updated. 

WinCuePro News also displays the number of words to the end of the script from the 

position of the cursor within the script. The number of words to the end of the script is 

displayed in the Words To End box. 

The Script Duration Boxes 

The time taken for a person to read a script from the prompter screen will depend on 

the number of words in the script and how fast that person reads. WinCuePro News 

uses the current word count and the presenters read rate to calculate the duration of 

the script. The script duration in seconds is displayed in the Total Time box and this is 

also constantly updated. 

The default read rate of 180 words per minute is used if the read rate is unknown. 

WinCuePro News also displays the time to the end of the script from the position of 

the cursor within the script. This is calculated in the same way as the Total Time. The 

time to the end of the script is displayed in the Time To End box. 
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5.2 Changing the Script Characteristics 

The following sections give general information about formatting scripts to suit 

individual preferences. 

Changing the Font 

You may wish to change the font of a script to suit individual presenters for example. 

Choose Format, then Font from the menu. A dialog box Select Font will appear. Click 

on font required in the Available Fonts list and the sample box will give you a preview 

of your selection. Use the Font Size text box to set the font to an appropriate size. 

When you are happy with the font setting click on OK. 

When you have highlighted the text click the font button: 

 

Changing the Font Style 

Changing the style of the characters or words within a script can help them to stand 

out from the main body of the text. The styles available to any font are bold, italic and 

underline. 

Choose Format, then the style you want to use (Bold, Underline or Italic) from the 

menu. When you begin typing the characters will appear in the style you selected. 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To change style 

Ctrl + B To bold 

Ctrl + U To underline 

Ctrl + I To italic 

Click the style buttons on the toolbar: 

   
Bold Underline Italic
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Changing the Color of the Text 

In addition to changing the style of characters in a script, you can also change their 

color.  

 

 

Choose Format, then Color from the menu. A sub menu appears and from this you 

can select the color required. When you begin typing the characters will appear in the 

color you selected. 

There are also shortcut keyboard controls as shown in the table. 

 

 

Inverting the Background Color and the Text 

The background color of the text can be changed in WinCuePro News. The default 

color is a black background with the characters in white. Using the Inverse function 

the characters will be black on a white background. For another example, if the 

characters are blue with a black background, when the inverse function is used the 

characters will be black on a blue background. 

Key To colour change

Ctrl + 0 Default*

Ctrl + 1 Red

Ctrl + 2 Green

Ctrl + 3 Blue

Ctrl + 4 Yellow

* The Default color is usually white characters on a black background. If 
Inverse is selected the characters will be black. 

Click on the color buttons on the toolbar: 

 

 
When you have highlighted the text click on the inverse button: 
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Choose Format, then Inverse from the menu. When inverse is selected it will have a 

check mark ( ) in the menu. 

There are also shortcut keyboard controls as shown in the table. 

Key To inverse 

Ctrl + E Text and background colors 
 

Justifying the Text 

WinCuePro News supports both left and right justified text in the script window. To 

change the justification of text, choose Format then Justification from the menu. A sub 

menu appears and from this you can select either Left or Right. Once selected it will 

have a check mark ( ) against it. When you begin typing the text will be justified 

according to your selection. 

 

 

 

There are also shortcut keyboard controls as shown in the table. 

Key To justify 

Ctrl + Alt + L Left 

Ctrl + Alt + R Right 
 

Highlighting Text in the Editor 

You may want to select text from within a script and change that in some way, such 

as deleting, copying or changing font. Therefore in order to do this you must first 

select the text by highlighting it. You can highlight using the mouse or keyboard. There 

are also shortcut keyboard controls as shown in the table. 

Click on the justify buttons on the toolbar: 
 

 
Left  Centre  Right 
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Key To Highlight 

Shift +  One character to the right 

Shift + Ctrl +  To the end of a word 

Shift + Home To the beginning of a line 

Shift + End To the end of a line 

Shift + Page Up One screen up 

Shift + Page Down One screen down 

Shift + Ctrl + End To the end of a script 

Shift + Ctrl + Home To the beginning of a script 

Ctrl + A Highlight all text 
 

Once the text is highlighted you can then make any changes in format, copy or delete. 

Captions 

Those of you running WinCuePro News with a caption generator may want to select 

particular parts of the script that won’t be sent to the caption generator. Select the text 

by highlighting, and then choose Format, then Not Captioned from the menu. The 

marked text will not be sent to the caption generator. 

Format All 

For simple formatting of the entire script choose Format then All text… from the menu. 

The Format All dialog box will appear. To select Bold, Italic, Underline, Inverse simply 

press the button. To change the font press the Font button, a Select Font dialog box 

will be displayed, choose your font and size. When your happy with your selection 

click OK. 
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Not Prompted Text 

There may be text within your script that you don’t need to prompt. Select the text by 

highlighting, and then choose Format, then Not Prompted from the menu. This text 

will then not appear on the prompter’s output. 

Finding Words in a Script 

To search for a particular word in the current script, choose Edit, then Find, or just 

press Shift F3. A dialog box will appear. Type the word you are looking for and click 

OK. WinCuePro News searches from the current cursor position to the bottom of the 

script. If it finds the word you specified, it will highlight it; otherwise it will ask if you 

want to continue searching from the top of the script. A warning will be displayed if the 

word is not found. You can search for the same word again by choosing Edit, then 

Find Next, or by pressing F3. 

Replacing Words in a Script 

To replace one or more words within the current script, choose Edit, then Replace. 

The Replace dialog box will appear. Type the word or phrase you wish to find in the 

‘Find what:’ box, and the word or phrase you want to replace it with in the ‘Replace 

with:’ box. Then use the Find Next and Replace buttons to control the replacements 

manually, or click the Replace All button to automatically make the changes. 
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5.3 Creating Your Own Settings For New Scripts 

You can setup WinCuePro to produce all your new scripts in the format you want. 

5.3.1 Changing the Default Read Rate 

The read rate is defined as the number of words spoken in one minute. WinCue uses 

the default read rate of 180. 

Note: Items must be checked in the Presenter Settings before they can be 
modified.  See section 5.4.2 

To change the default read rate you have to change the settings for the default 

presenter. Open the File menu and select Properties… The Properties dialog box 

appears. Now click the Presenters tab:  

 

Select the Default presenter and click Modify. The Attributes window is then 

displayed.  In the Read Rate text box, type in the new value for the default read rate 

and click OK.   
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5.3.2 Changing the Default Font and Font Size 

WinCuePro can prompt any font installed on your PC. You can change the font used 

for any new scripts you create again by changing the default. 

When in the Attributes window click the Modify Font button.  A Select Font dialog box 

will appear: 

 

Select from the list of available fonts and the required font size. A sample of the 

selected font will be displayed to assist you. When you are happy with the font setting 

click on OK. 
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5.4 Presenter settings 

Presenter’s settings allow you to customize settings for individual presenters. The 

font, color, style and read rate can be allocated for individual presenters. These 

settings will be automatically applied to the script when the presenter is selected. 

5.4.1 Adding a New Presenter 

You can add a new presenter to the list of presenters. Open the File menu and select 

Properties… The Properties window opens. Click on the Presenters tab to open the 

list of currently defined presenters. To add a new presenter, click on Add.  The 

Presenter Properties dialog box opens. Enter the presenter’s name in the Presenter 

Name text box and click OK. The new presenter will then be shown in the list of 

Currently Defined Presenters.  

5.4.2 Changing the Presenter Settings 

To change a presenter’s settings open the File menu and select Properties… The 

Properties dialog box appears. Click on the Presenter Settings tab.  

If an attribute is checked ( ) the setting becomes optional in the Presenters window. 

This means you can choose to set that attribute for individual presenters.  
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5.4.3 Modifying a Presenter 

To modify a presenters’ settings click on the Presenters tab.  Select the presenter 

from the Currently Defined Presenters tab and then click Modify. The Attributes tab is 

then displayed: 
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Here you can change the Presenter Name, specify the required style by clicking in the 

relevant checkbox. If a box is checked ( ) that style will be used in the editor.  The 

Color can be selected from sub menu. You can change the Read Rate and Robotic 

Stand Height if applicable. 

Note:  An attribute that is set for a presenter cannot then subsequently be 
modified within the text. 

Make any changes to the settings required and when you are happy with the settings, 

click on OK to save your changes.  

5.4.4 Deleting a Presenter 

In the Presenters window, select the presenter from the list of Currently Defined 

Presenters and click on the Delete button to delete. 

Click on OK to exit the Properties window and save the changes. 
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 WinCuePro News Rundowns 
 

In this chapter we learn how to create rundowns and work with a number of stories. By the end of 

this chapter you will be able to prompt using multiple rundowns. The chapter assumes the 

knowledge of the basics and the script editor.  

6 Working with Rundowns 

6.1 The WinCuePro News Rundown Window 

The WinCuePro News Rundown window consists of two parts, the WinCuePro News 

Rundown and the Script Editor. The rundown displays a list of the stories, which will 

be displayed for the presenter. The stories are then prompted in the order they appear 

in the rundown list. The Script editor is used to create the text attached to each of the 

stories. 

See Chapter 5 for more information on the script editor. 

Chapter
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Features of WinCuePro News Rundown 

This provides a brief overview of all the features most of which have been described 

in the previous section. 

 

 ID this provides a unique number for all stories in the rundown and is not connected 

with the running order  

 Story Title simply a title to identify the individual stories 

 Words provide a word count of the number of words in the script displayed in the 

Script Editor. 

 Link this is the time for this script based on the set read rate. (Default read rate 180 

words per minute). 

The Script Editor Window 

The Script Editor window displays the Story title at the top and below three text boxes. 

Firstly the ID number of the story is displayed in the first box labelled ID. Secondly the 

word count box which displays the number of words in the script, labelled Words. 

Finally the duration of the script based on the number of words and the set read rate is 
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displayed in the box labelled Time.  The Script editor is used to create the text of the 

script, which will be displayed on the prompter’s screen. 

 

The size of the Script Editor window can be adjusted. As you move the pointer onto 

the left hand side of the frame the pointer changes shape. When the pointer changes 

shape click the mouse button and drag to the desired width. 

 

 

6.2 Working in the Rundown 

6.2.1 Creating a New Story 

To create a new story select Story, then New from the menu. A sub menu appears 

and from this you can select Single-column Script or Single-column Break.  

A Single-column Break can be used to split the rundown into sections and is often 

used for commercial breaks. The total times for each section can be displayed in the 

running order by the break item. 

Choose Single-column Script and the New Item Title dialog box appears. Enter the 

story name in the text box and click OK. 

The new story will appear in the Rundown under Story Title. 

Sizing Pointer 
II  
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6.2.2 Saving your work 

It is good practice to save the rundown and scripts regularly to ensure no information 

is lost accidentally. To save choose File, Save As from the menu.  

OR click the Save button on the toolbar: 

 

A Save As dialog box will be displayed. Enter the name of the Rundown in File name 

text box and click Save. 

6.2.3 Moving Stories Within the Running Order 

The stories within a rundown can be reordered very easily using the drag and drop 

facility in WinCue. Drag-and–drop is the easiest way to move a story within a 

Rundown. Select the story you want to move by pointing to it and hold down the left-

hand mouse button. When the drag and drop pointer appears, drag the dotted 

insertion point to the new location. Release the mouse button to drop the story in its 

new place in the runorder. 

6.2.4 Renumbering Stories in the Rundown 

The stories within a rundown can be renumbered at any stage when lines are added 

or deleted. Choose Rundown, then Renumber from the menu. 
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6.3 Editing Within the Rundown 

It is possible to edit within the rundown by using the right mouse button. This will be 

quicker and often more convenient than the pull-down menus. Right-clicking on an 

item in the rundown will display a menu with options such as to add a new story or 

edit an existing story: 

 

6.3.1 New story 

To add a new story to the rundown, right-click on the position in the rundown where 

you want it to be added above.  Select New from the pop-up menu, you can then 

select Single-column Script or Single-column Break. Choose Single-column Script 

and the New Item Title dialog box appears. Enter the story name in the text box and 

click OK. 

6.3.2 Edit Story 

Right-click on the story you want to edit and select Edit Story from the pop-up menu.  

6.3.3 View Story 

To do this click once with the right mouse button on the line you to view. A menu 

appears next to the cursor. Select View Story from this menu. Viewing the text allows 

you to read the text attached to a story and allows you to make changes to it.  

6.3.4 Delete Story 

It may be necessary to delete stories from the rundown. To do this click once with the 

right mouse button on the line you wish to delete. A menu appears next to the cursor. 
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Select Delete from this menu. A dialogue box will appear Sure you want to delete this 

item? Click Yes to delete. The item will be deleted from the rundown and the text from 

the Script Editor. 

The item can also be deleted by selecting it from the rundown list and using the menu 

commands. Choose Story, then Delete from the menu. A Dialogue box Sure you want 

to delete this item? will appear. Click on Yes to delete. 

6.3.5 Deleting Multiple Stories 

It may be necessary to delete multiple stories from the rundown. This removes the 

highlighted lines and the attached text contained in the Script Editor. 

Hold the Ctrl key on the keyboard and click once on each of the stories you wish to 

delete from the Rundown. Choose Story, then Delete from the menu. A Dialogue box 

Sure you want to delete this item? will appear. Click on Yes to delete. 

Alternatively, hold the Ctrl key on the keyboard and click once on each of the stories 

you wish to delete from the Rundown. Click once on the right mouse button on any 

highlighted story. A menu appears next to the pointer. Choose Delete from the menu. 

A Dialog box  Sure you want to delete this item? will appear. Click on Yes to delete. 

6.3.6 Edit Field  

The unique title field in the rundown simply identifies each individual story. The title 

field should contain a one or two word description of the story. To do this click once 

with the right mouse button on the story you wish to edit. Choose Edit Field from the 

menu. The title field will now appear white indicating you can now edit. Make your 

changes and when you are happy click on the left-hand mouse button or press enter. 

If you have a three-button mouse it’s even simpler. Just click on the story you wish to 

edit with the middle mouse button 

To edit the field directly with a two button mouse press Ctrl and press the right hand 

button on the mouse to edit the field directly. 

6.3.7 Toggle Hold State 

Toggle Hold State allows you place an item in the rundown, which will not be 

prompted and will not be included in any timing calculations. This allows stories to be 
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on standby. To do this click once with the right mouse button on the line you wish to 

hold. A menu appears next to the cursor. Select Toggle Hold State from this menu. 

The item selected turns blue. 

6.3.8 Prompt From Here 

The Prompt From Here command allows you to begin prompting from anywhere 

within the rundown. To do this click once with the right mouse button on the line you 

wish to begin prompting at. A menu appears next to the cursor; select Prompt From 

Here from this menu. The rundown then goes into prompting mode and the item 

selected, as the first turns yellow. 

 

6.4 Working with Multiple Rundowns 

WinCuePro News will allow the user to have a large number of rundowns and Script 

Editor windows open at the same time. However, to limit the confusion it is best to 

have only one open at a time. 

WinCuePro News provides a number of standard tools to help organize multiple 

rundown windows. The rundown windows currently opened are displayed on the 

window bar. 

Tiling windows 

The windows can be tiled this enables the operator to see part of all the rundowns on 

one screen. The way in which the windows are tiled depends on how many are open. 

If you wish to see only the Rundown windows, then close all the Script Editors 

windows. Choose Window, then Tile Horizontally or Tile Vertically from the menu. The 

tilling can be horizontal or vertical depending on what you prefer. To make a window 

active choose the corresponding Rundown name from the window and click on it. 

Cascading Windows 

Cascading windows arranges all the open windows one behind each other with their 

titles visible. The top window is the only one that can be seen complete. 
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Once again if only the Rundowns are to be cascaded, close all the script editors. 

Choose Window, then Cascade from the menu. All the open windows are stacked so 

their titles are visible. 

To bring a chosen rundown to the front, choose click on the rundown name in the 

stack or click on title on the status bar. 

Arranging Icons 

All the open windows can be minimized to icons. These icons can become 

disorganized; Arrange places them in an orderly fashion. 

Choose Window, then Arrange from the menu. All the icons will be arranged in an 

orderly fashion at the bottom of the WinCuePro News window in the Status bar. 

Moving Stories Between Rundowns 

Stories can be moved between Rundowns very easily using the drag and drop facility 

in WinCue. Drag-and–drop is the easiest way to move a story between Rundowns. 

Select the story you want to move by pointing to it and hold down the left-hand mouse 

button. When the drag and drop pointer appears, drag the dotted insertion point to the 

new location. Release the mouse button to drop the story in its new place in the 

Rundown. 

 

6.5 Prompting Mode 

When WinCuePro News enters the prompting mode the stories in the chosen 

rundown can be scrolled. The prompter operator controls the speed at which the text 

is scrolled to suit the presenters read rate. The stories within a rundown can be 

skipped or returned as necessary. 

 

Entering Prompt Mode 

To start the prompter choose Prompt, then Begin Prompting from the menu. The first 

item on the rundown list appears yellow indicating that this is the current item 

prompting. The prompter operator can now control the text on the prompter using the 

scroll controller. 

See Chapter 7 for details of the different scroll controllers and there set up 

A yellow bar on the rundown order indicates the story you have selected 
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Controlling Prompted Text 

The prompter operator uses the scroll controller to vary the text scroll speed, the 

direction, to skip backwards and forwards between stories in the rundown. There are 

a number of other options available, within the Prompt menu, when prompting. 

Choose Prompt, then any of the following from the menu: 

Edit at Prompt Position Allows editing at current position 

Script Lock Mode Stops prompting and set prompter at the 

beginning of current item 

Jump prompt to editor Skips to start of current item and continues 

prompting 

Refresh Prompt Output Skips back a couple of lines and continues 

prompting 

 

A check mark ( ) indicates the command is on. 

Quitting Prompt Mode 

To quit the prompter, choose Prompt, then Stop Prompting from the menu.
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Scroll Controls 
 

In this chapter you will learn how the prompter works. You will find out about the various scroll 

controls, configuring the prompt output and editing while in prompt mode. 

7 The Prompter 

7.1 The IMT Scroll Control 

WinCue is supplied with an IMT scroll control as standard, which plugs into the IMT 

card. WinCue also supports on-screen scroll controls, using a mouse.   These are the 

scroll controls supported by WinCue: 

1. On-screen Scroll Control  

2. IMT Scroll Control 

3. Hybrid Serial IMT Multibutton Controller 

4. Foot Control  

 

7.2 Selecting a Scroll Control 

Choose Tools then Options… from the menu. Double click on Prompt Engine, then 

click on Scroll Controls. The Configure Scroll Controls dialogue box appears. Select 

the type of control you wish to use. 

Chapter
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7.3 On-screen Scroll Control 

The On-Screen Scroll Panel enables you to prompt text using the mouse. In the event 

of your normal scroll control failing this is a convenient backup. 

The Scroll Control Panel features a speed control slide bar, which is used for varying 

the speed of the prompted text. Click on the left-hand button of the mouse and slide to 

operate. The slide bar has a center stop position. When it is above the center position 

text will be scrolled up the screen. When it is below the center position the text scrolls 

down the screen. 

The Top of Queue button on the screen Scroll Control Panel changes the current 

prompt position to be the start of the script or rundown. 

The Top of Story button on the screen Scroll Control Panel changes the prompt 

position to the start of the current script being prompted. 

The Halt button on the screen Scroll Control Panel stops the prompted text. 
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7.4 IMT Scroll Control 

The IMT scroll control is supplied with WinCue and is connected to the IMT card. This 

scroll control does not require any kind of configuration. 

Click on IMT Card Scroll Port, then click on OK. You can how use the IMT scroll 

control to prompt your scripts. 

 
The simple serial scroll control is connected to a free serial communication port. In 

Standard Configuration the simple serial scroll control allows you to scroll the 

prompted text up and down the screen and jump between markers.   

 To scroll the text, turn the knob at the end of the scroll control clockwise to speed 

up and anti clockwise to slow down.   

 To change the direction of the prompted text press the black button 

 To jump to the next marker press the red button  

7.4.1 Configuring for Center Stop Mode 

The IMT Scroll Control can be set up for Center Stop mode. In the Configure Scroll 

Controls dialogue box, click on IMT Card Scroll Port. Now click on the Setup button to 

configure simple serial hand control. The Configure Scroll Control dialog box appears: 
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The red and black buttons can be configured to perform the desired function.  Usually 

the red button is used for jumping to the next marker in the current direction and the 

black button to change direction. However if you are employing center stop mode the 

black button can be used for some other function. Click the down arrow next to the 

text box and select the required function from the drop-down list.  

Center Stop Mode is used if the operator does not want to use the forward reverse 

button to change the direction of the prompted text. To enable Center Stop Mode, the 

Center Stop Mode check box should be checked ( ).   

7.4.2 Configuring the Scroll Table 

Click the Configure IMT End Stop or Center Stop Scroll Table Tab depending on the 

mode you are using.  The simple serial scroll control sends serial data in the range 0 

to 120 to tell WinCue how fast to prompt the text; 0 is stop and 120 is the fastest scroll 

rate. This scroll rate is determined by the position of the scroll control knob. If the Stop 

Point is set to 60, scroll rates of less than 60 will prompt the text backwards, scroll 

rates greater that over 60 will prompt the text forward, and a scroll rate of exactly 60 

will stop the text from scrolling.  The Stop Zone is a range between 0 and 40 over 

which the prompted text does not scroll. If the Stop Point is set to 60 and the Stop 
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Zone is set to 5, scroll rates between 55 and 65 will mean the prompted text is not 

scrolled. 
 

 Warning! 

Users should not attempt to modify the IMT End Stop Scroll or IMT Center Stop 
Scroll Tables.  If modifications are required to either scroll table you should 
contact your vendor. 

 

 

7.5 Hybrid Serial IMT Multi-button Controller 

The serial multi-button scroll control is designed to work with rundown queues 

(rundown queues are not supported in WinCue LT). It is connected to a free serial port 

on the back of the PC. It has a number of additional buttons not found on the IMT 

simple serial or on screen scroll controls. These buttons simplify prompting scripts in a 

rundown as they can be configured to perform a large variety of functions. In addition 

this control allows the attachment of an optional foot control, enabling hands free 

prompting by a presenter. 

7.5.1 Configuring for Center Stop Mode 

In the Configure Scroll Controls dialogue box, click on Hybrid Serial/IMT Multibutton 

Controller. Now click on the Setup button, the Configure Hybrid Serial Multibutton 

Controller dialog box will appear: 
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The General tab is used to set which communications port the multi-button scroll 

control is attached to and, if required, set it up for Center Stop Mode. Center Stop 

Mode is used if the operator prefers to use the scroll knob to change the direction of 

the prompted text rather than/as well as use the FWD/REV button. To enable the 

Center Stop Mode, the check box should be checked ( ).  

7.5.2 Configuring Scroll Control Buttons 

The Buttons tab allows the user to configure each of the buttons individually. The 

buttons are pre-configured for use. The standard settings are as shown below: 
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However, these buttons can be customized to suit the user.  When the user clicks on 

a button they are presented with a list of the available button functions that have not 

been assigned. Select the function required from the list.  
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Function Description 

Change Direction Changes the direction the text is scrolled 

Next Story Moves the prompter to the next story in 

the rundown 

Previous Story Moves the prompter to the previous story 

in the rundown 

Reset Story Moves the prompter to the beginning of 

the story currently being prompted 

Next Marker Moves the prompter to the next marker 

in the story 

Previous Marker Moves the prompter to the previous 

marker in the story 

Reset Rundown Resets the prompter the top of the 

rundown 

Blank Screen Blanks the prompted text from the 

prompter(s) on the on-camera unit(s) 

Caption On/Off Switches caption data sent by WinCue 

on and off 

  

Clear Decoder Clear the caption output 

Stop Stop the prompted text scrolling 

 

Top Row of Buttons 

Middle Row of Buttons 

Bottom Row of Buttons 
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7.5.3 Connecting a Foot Control 

At the rear of the multi-button scroll control is a 15 pin D connector for attaching a foot 

scroll control and a button to select between foot and hand control operation. When 

this button is pressed in the foot scroll control can be used to prompt the text. 

Otherwise the multi-button scroll control can be used. 

 
 

 
The foot scroll control is used for controlling the speed and direction of the prompted 

text only. All other functions such as next marker and reset rundown are available by 

using the buttons of the multi-button scroll controller. 

The red button is used for changing the direction of the prompted text. The foot pedal 

controls the speed.  

 

�The rear of the Multi-
button Scroll Controller 
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7.5.4 Multi-button Troubleshooting 

If you are having problems with your scroll control, for example you cannot scroll or the scroll 
control button are not doing what they should, use the following steps to try and troubleshoot the 
problem before calling QTV Technical Support (See Technical Support section at the back of this 
guide). 

1. Check to make sure that the "foot/hand" button on the back of the Multi-button hand 
control is not pushed in (if it is the scroll control needs a foot pedal to scroll).  

2. Check to make sure that you have selected the correct scroll control in the WinCue 
configure scroll controls set-up menu (see section 7.2). 

3. Check that all the required buttons are configured correctly in the Configure 
Controller section (Note: these will be automatically set-up when you install WinCue 
however they may have been manually changed).   

If none of the above solves to be the problem don’t then hesitate to contact the QTV Technical 
Support line.

TThe Foot Scroll Control 
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Appendix A The IMT Card 

 
In the following appendix we will look at the entire configuration options available for 

the IMT board. 

 
 

 
Card Layout A2 
Termination - J6 A3 
Power to Bus for SCSI Termination - J6 A3 
SCSI ID – SW2 A4 
SCSI/Parallel Select - SW2 A4 
Video (PAL or NTSC) - J11 A5 
          SECAM A5 
External Power Supply - J12 A6 
Composite Video Features Connector - J10 A6 
Other Jumpers A6 

 
 
 

The IMT card is configured at the factory to work in your country. It is unlikely that you 

will need to make any changes to it. If you do, read the relevant section(s) carefully, or 

consult your supplier for further help before changing the configuration of the board. 

 
A2 Card Layout 

 
The following section shows the 3 IMT card layouts that have been produced over the 

years, most recent of which being the Issue 3 I.M.T card. You will have been supplied 

with one of the 3 IMT cards, use the diagrams below to help you locate all the 

connectors and jumpers on the card that you have been supplied with. 
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IMT Card – Issue 1. 
 
                  Genlock Port 
 

    SCSI Card Connector  Parallel Port Connector                      Reset Button 
 

 
 
Even flash ROM chip Odd flash ROM chip            IMT Scroll 
                 Control Port 
 

                                                 Composite Video Port 
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IMT Card – Issue 2. Connector Detail 
 

 
 
IMT Card – Issue 3. PCI card 
 
                                 

 
 

Composite 
Video 

Genlock 

IMT Scroll 
Control 
Port 

SCSI Card 
Connector 
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A3 Termination - J6 

 
By Default the IMT card is terminated, and is expected to be connected 

to the end of the SCSI cable. Termination can be enabled/disabled by 

changing a jumper setting on J6. 

 

 
 

To enable termination of the IMT card place a jumper on 
leftmost pins of J6 

To disable termination of the IMT card remove the jumper 
on leftmost pins of J6 

 
 
 
 

A3 Power to Bus for SCSI Termination - J6 

 
J6 is used to determine whether the IMT card is terminated and to 

determine the source of termination power. 

 

 
 

If you have enabled termination on the SCSI card you will need to set 

the source of termination power. 

 
To enable external termination power for the SCSI bus 
connect pins 5 and 7 of J6 

To enable internal termination power to the SCSI bus 
connect pins 7 and 8 of J6 

 
 
 
 
 
 

See Also 
See below to learn about 
power to bus SCSI 
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A4 SCSI ID - SW2 

 
By default, SCSI ID is set to 3. It can be changed using dipswitches 1,2 

and 3 on SW2. 

 

 
 

When a dipswitch is in the top position it is on. When it is in the bottom 

position it is off. The dipswitch positions for each SCSI ID is shown in the 

table below: 

 
 Dip Switches 

SCSI ID 1 2 3  
0 On On On 

 
1 On On Off 

 
2 On Off On 

 
3 On Off Off 

 
4 Off On On 

 
5 Off On Off 

 
6 Off Off On 

 
7 Off Off Off 

 
 
 
 
 

A4 SCSI/Parallel Select - SW2 

 
The IMT card can prompt using data sent through either the SCSI port 

or parallel port of your PC. By Default it is set up to use SCSI. Dip 

switches 4 on SW2 controls whether the SCSI or parallel port is used. 
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When a dipswitch is in the top position it is on. When it is in the bottom 

position it is off. The dipswitch positions for SCSI/parallel port selection 

is shown in the table below: 

 
 Dip Switch 

Port 4  
SCSI Off 

 
Parallel On 

 
 
 
 
 

A5 Video (PAL or NTSC) - J11 

 
The IMT card can produce either a PAL or NTSC composite video 

signal. The signal available from the composite video port will have been 

set at the factory, prior to dispatch. The signal type can be changed by 

setting a jumper on J11 (Card Issue 1) or with switch 3 (Card Issue 2). 

 

Issue 1 Issue 2 

 
 

 

 
To enable NTSC place a jumper on leftmost 
pins of J11, or turn Switch 1 on. 

  

To enable PAL remove the jumper on 
leftmost pins of J11, or turn Switch 1 off. 
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SECAM 

 
To configure the IMT card for SECAM composite video output use the 

same jumper setting as PAL on J11. In the WinCuePro News software, 

from the Prompt menu choose Configuration then Prompt Engine and 

ensure that Color Burst is disabled. These settings will generate a mono 

composite output. 

 
 
 

A6 Internal and External Power Supply - J12 

 
If there is not an ISA slot available in your PC for the I.M.T card you will 

have to use the J12 External Power Header (as shown in the diagram 

below) to connect the IMT card to your PCs power supply. To do this 

firstly check to see if you have a free power socket in your PC, then use 

the supplied power adapter cable to connect the J12 External Power 

Header to a free Power Header on your PCs power supply. 

 

J12 External 
Power Header 

4 Way Power 
Plug 
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In systems where the IMT card is not fitted inside the PC, it is powered 

by an external power supply. This power supply is connected to J12. 

This appears as an 8-pin connector on Issue 1 cards, and a 3-pin 

connector on Issue 2 cards. 

 
 

If you need further information about powering the IMT card from an 

external power supply please contact your supplier. 

 
 
 

A6 Composite Video Features Connector - J10 

 
The Composite Video Features connector allows additional 4 composite 

video ports to be added to your PC.  To find out more about this product 

contact your supplier.   

 

Do not attach anything to any of the pins on J10. 

 
 
 

A6 Other Jumpers 

J1 and J5 

J1 is the debug port. It supplies serial debugging information. Do not 

attach anything to any of its pins. 

 

J5 is the flash reset port.  Do not attach anything to any of its pins. 
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Appendix B Supported Hardware 

 
The following appendix details hardware devices recommended for use 

with WinCuePro News. If you wish to use devices not listed here, please 

contact your vendor. 

 

SCSI Cards 

 
QTV has tested a range of SCSI cards. Those listed below have been 

found suitable for use with WinCuePro News. If you do not find your 

SCSI card listed below, please contact your vendor. 

 
SCSI Cards for Desktop PCs 

 
Manufacturer Type Bus 
Adaptec 2906 PCI 

 
SCSI Cards for Laptops 

 
Manufacturer Type Bus 
Adaptec APA 1460A-2 Slim 

SCSI 
PCMCIA 
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Appendix C Wiring Diagrams 

 
The following appendix contains wiring diagrams to aid you in 

connecting WinCuePro News in a number of configurations. You may 

find that many of the wiring diagrams are not appropriate for your 

system. 

 
 

Contents 

 
Standalone Prompter Wiring Diagram  C2 

Laptop and IMT Box Wiring Diagram (UK) C3 

Laptop and IMT Box Wiring Diagram (US)  C4 

Edit Station Wiring Diagram   C5 

Standalone Edit Station Wiring Diagram  C6 
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C2 Standalone Prompter Wiring Diagram 
 
 

     
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 
 

              
 
 
  
 
 

             To Mains 
  Power 
               Supply 
 
 
Key   
 - Essential cabling 
 - Optional cabling 
  
 

VGA Port 

Power to 
Monitor 

Genlock 
Port 

 

 
Video Distribution 

Amplifier 
(Optional 
Internal) 
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C3 Laptop and IMT Box Wiring Diagram (UK) 
 
 

 
 
 
  

 
 
 
 

   

 

 

 

Powering the IMT Box: - Choose between AC power supply and 12 volts DC 

 

Genlock 
Input PCMCIA 

SCSI Card

On Camera Units 

Laptop Computer 

IMT Scroll Control 

Video 
Out 

Parallel 
Port 

SCSI 
Port 
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C4 Laptop and IMT Box Wiring Diagram (US) 
 
 

 
 
 
 

 

 
 
 
 
 

 

   

 

 

Powering the IMT Box: AC or DC Power 

 

Genlock 
Input 

PCMCIA 
SCSI Card

On Camera Units 

Laptop Computer 

IMT Scroll Control 

Video 
Out 

DC Power

DC Fuse 

SCSI Port 

On/Off DC 
Power

AC On/Off Power 
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C5 Edit Station Wiring Diagram 
 
 
 
 
 
 

 
 
 

              

                            
 
 
 
 

 
 
 
 
 
 
 

 

To Mains 
Power 
Supply 

VGA Port 
Power to 

VGA Monitor 

 
 

Ethernet Hub 
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C6 Standalone Edit Station Wiring Diagram 
 
 
 
 
 
 
 
 
 
 

 
 
 

              

                            
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Security 
Sentinel 

To Mains 
Power 
Supply 

VGA Port 
Power to 

VGA Monitor 
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Appendix D Using PC90 Motorised Control Stands 
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PC90 Motorized Control Stands are used to display text to the speaker during 
speeches, this appendix will explain how to configure and use these stands for 
WinCuePro News AP ENPS. 

Firstly, connect the stand to a serial port on the back of the computer that will be 
running WinCue using the lead provided. Note which serial port you connect it to. 

D1 Configuring WinCue 

With WinCue running go to the Tools menu and select Options. A list of options 
will appear one of which will be Automation Services. Double-click on this option 
or click the plus sign next to it to reveal two options - Local Device List and 
Master Device List. Highlight Master Device List by clicking on it and a blank 
list will appear on the left. Click on the Add button to add the new device. 

Make sure the device type is set as PC90 Automated Conference Stand and 
then type in a name for the device. This can be anything within reason. A 
suggestion is PC90 Device. Select OK and specify the settings for the stand. The 
COM port is the serial port number the stand is connected to. The Stand no for 
presenters specifies which stand is controlled for the presenter in a multiple 
stand setup. In a single stand setup this can be left as Stand 1. 

Click on OK and this device will appear in the list. Now add it to the local device 
list as well so it can be controlled from the machine running WinCue. Highlight 
Local Device List by clicking on it and then click on Add to add the device to the 
local list. Select the previously named device by clicking on it and then click on 
OK. The device is added to the list. The configuration is now complete. 

D2 Controlling the PC stand from WinCue 

A control panel can be brought up to control the stand at any time by selecting 
Control Panels from the Automation menu. The previously configured device 
will appear on a sub-menu. Click on this and a panel like the one below will 
appear. 
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Click on Activate to start controlling the stand. Use the height slider bar to control 
the height of the PC90 stand. This is a useful way to confirm that the connection 
between the computer and the stand is working. 

NOTE: While the panel is active WinCue cannot control the stand whilst 
prompting. Use the panel only to manually control the stand. When the 
stand is to be controlled through prompting close the control panel. 

D 3 Controlling the stand through prompt scripts 

The stand height can be controlled by inserting a special control into a script at a 
particular point. When this point is reached in the prompting the stand will be set 
to the height that this control specifies. 

When editing a script place the cursor at the point where the stand should change 
height. Select Automation Element from the Insert menu. Select PC90 Stand 
Control and the following dialog will appear: 
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The device name can be set to the previously configured device or, if there is only 
one stand, it can be left as (Any device). Specify which stand will be controlled in 
a multiple stand setup (this can be left as Stand 1 in a single stand setup). 
Choose the new height for the stand and any comment that should appear next to 
this control in the script. Click on OK and the control will appear in the script 
where the cursor was.  

This control can be double-clicked on to change the settings entered above. 

NOTE: Before prompting the script the device must be activated so that WinCue 
can control it. This is done by choosing Devices from the Automation menu and 
selecting the previously named device. 
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Appendix E Wiring 

E1 WinCue Multibutton Hand Control 

E1.1 WinCue IMT card 9 way d connections 

1 0v 
2 0v 
3 gnd 
4 +5 
5 +5 
6 pot 
7 n/c 
8 marker 
9 fwd/rev 
 
pot = 10k  
 
 

E1.2 9 way d Serial port connections 

2……..rd……..brown 
4……..dtr…….. yyyeeellllllooowww 
5……..gnd…….. wwwhhhiiittteee 
7……..rts……..purple 
 
dtr and rts are used to generate the supply voltage 
 

E1.3 P4 Multibutton Remote Connector 15 Pin D Male 

9……..+ 5v……..Red 
10……..0v……..Black 
11……..Pot……..Green 
12……..Fwd/Rev……..Blue 
 
500k pot for Foot control 
 

E2  2 button Serial Hand Control 

E2.1 9 way d Serial port connections 

2……..rd……..Red 
4……..dtr……..Blue 
5……..gnd……..Green 
7……..rts…….. YYYeeellllllooowww 
 
dtr and rts are used to generate the supply voltage 
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E3 2 button IMT Hand Control 

E3.1 IMT Hand control 

1……..5v……..Red 
5……..0v……..Black 
6……..pot……..Green 
8……..marker……..YYYeeellllllooowww  
9……..fwd/rev……..Blue 
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Appendix F Master/Slave 

The concept of remote prompting is to have one prompt operator controlling a 
second prompt output over a remote modem link or by direct serial connection. 

The Workstations at both ends need to have the same version of WinCue 1.3 and 
an IMT card installed.  These Workstations can each function as standalone 
prompters if required. The Master Workstation and the Slave Workstation can be 
connected together across the public telephone network by modem, or by direct 
serial connection if available. 

The Master Workstation can use script information either from a local file, which 
can be created and modified locally, or from a newsroom system through one of 
the standard newsroom system interfaces. 

 

F1 Before you start 

Before you start you should ensure that you have the following: 

• 2 machines with the same version and build of WinCue 1.3 (you can find this 
out by checking under Help and About WinCue). 

• Both machines must have IMT cards.  

• Both machines must have the same Master/Slave configuration. 

• 1 scroll control for the Master machine (2 if you want to use the Slave 
machine as the Master as well). 

 

F2 Configuring WinCue for Master/Slave 

In order to setup the Master/Slave option in WinCue, click on the Tools menu and 
select Options. 

A list of all the configuration options available will be displayed. 
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Select the Master/Slave Interface option 

The Master/Slave Interface settings will appear opposite the Options list; by 
default Master/Slave will be configured to use a Serial Port connection, however it 
may need further port configuration or you may wish to connect via modem.   

 

 

F2.1 Serial Port Connection 

Configuring the Serial Port is very simple, just ensure that the Using Modem 
Connection option is not selected and the click on the Serial Port tab and choose 
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the COM port that you will be using to connect to the other machine. The other 
settings available for configuring the Serial Port connection are set to the optimum 
performance by default, so there is no need to change them.  

 

 

 

F2.2 Modem Connection 

To connect via a modem just select the Using Modem Connection option and 
enter the phone number that the other machine is connected to and leave all the 
other modem settings alone. If you have difficulty connecting via modem check 
with the manual provided with your modem for information on the modem reset 
string and the modem initialize string used by your modem, if the WinCue settings 
are different from these the change them to suit your modem. 
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F2.3 Other Master/Slave Configuration Options 

 
The other configuration options available in Master/Slave concern how the text is 
organized and displayed on both the Master and Slave machine, it is important 
that these settings are the same on both machines. More information about these 
settings can be found in your WinCue User Guide. 

 

F3 To set-up Master/Slave 

Once you have set up both machines according to the Before you Start section all 
you have to do is activate one machine as Master, this machine must have a 
scroll control attached to it, and activate the other machine as Slave. To do this 
click on the Master/Slave menu (which will appear after you enable Master/Slave 
Interface and choose the option for the machine’s role.  

Note: For information about setting up scroll controls see the relevant section in 
your WinCue User Guide. 
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F4 Using Master/Slave 

To use Master/Slave simply start scrolling from the Master machine and the Slave 
machine will copy its actions. To stop the Master/Slave option, click on the 
Master/Slave menu and select Deactivate.   
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Technical Support 

 

To receive technical help or advice for WinCue Pro, please call 
QTV during normal business hours at: 

 
(203) 406-1400 

 
E-mail technical support is available at: 

 
support@qtv.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you feel that there are important details missing from this manual please do not 
hesitate to email us here at QTV with a description of what you think is needed. 

Send the details to support@QTV.com 


